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Work in Progress
This feature lets you monitor project detail as the project progresses. It gives
you the ability to track, analyze, reconcile, and report on a valuable asset
within your organization. You can easily view cost detail. Using this informa-
tion, you can view all items on a sales ticket for a project, view whether the
line item is on a purchase order or whether the item is from job costing. If a
line item is on a P/O, the system lets you know whether the item has an in-
voice posted in accounts payable. If the posting is for a partial amount, the
system also displays this information.

You can print a copy of the Work in Progress Report which lets you compare
total dollars added to the ticket against those dollars that have been posted to
accounts payable and job costing. This allows you to quickly determine any
discrepancies between the recorded cost of goods sold and the actual cost paid
to vendors.

The Work in Progress (WIP) feature works with the After the Fact feature. The
After the Fact window lets you edit and make adjustments to work in
progress information. When you make changes to the information and post it,
the system updates the ATF-BATCH file which is stored on the G/L volume
serial. Until you release the information, you can return to the After the Fact
window and make as many corrections as necessary. After you release it, the
information is removed from the After the Fact window. In addition, both the
Work in Progress window and the GL-BATCH file are updated with the
changes you made. You can also use the After the Fact window to automati-
cally write-off and purge WIP information.

Note: You must be authorized to use Extended General Ledger Numbers to
use this feature. In addition, the Work in Progress feature is not in-
cluded in all software packages and may require authorization. For
more information, contact ECI² sales.

WIP provides many benefits for you and your business:

• Quick detection of discrepancies (can reconcile however often you
choose including daily, weekly, monthly)

• Accurate cost reporting (down to order, vendor and even item
level)

• Detect vendor under/overcharging or wrong contract pricing
used

• Uncover duplicate vendor payments

• Identify incorrect recording of cost of goods sold
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• No big write-off surprise at year end

• Better cost data enables better decisions:

• identify low GP products

• negotiate better contract pricing with vendor

• re-evaluate sales price

• encourage sales of higher GP items

• Commission calculation is more accurate and timely because in-
correct costs are trapped and identified when the order is in-
voiced

• Useful if you experience a lot of cost adjustments after invoicing

• Cost adjustments can be recorded to the salesperson or to the
house account

• More accurate budget forecasts

• Accurate and detailed financial reporting

• Aid in Invoicing/AR (can determine which orders have had ven-
dor payments but have not yet been invoiced)

• Track reasons for write-offs to determine any necessary corrective
action

• Inventory Management - if receiving into warehouse can deter-
mine product availability for an emergency - overall better control
and reporting of WIP and Inventory assets

Planning to Use the Application
To get started, set up the following:

• Authorization for the Work in Progress Feature (For more infor-
mation, contact ECI² sales.)

• Set the Work in Progress Parameters.

Setting Work in Progress Parameters
You can set Work in Progress parameters in the Parameter Editor window.
These parameters affect settings in the Work in Progress window and After
the Fact window.

1 From the Master Menu, double-click .
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2 Double-click .

3 From the Parameter Editor window, double-click Furniture.

4 Double-click Work in Progress.

5 Click General Configuration. The General Configuration options ap-
pear. See Figure 1. You can set the following parameters in this window.

5.1 In the Update Password box, enter a password restricting users
from editing work in progress information. This password is used
when accessing the Work in Progress Detail window.

5.2 In the WIP G/L Major box, enter the book and major general led-
ger numbers where the work in progress information is stored.
You can enter six digits in this box.

5.3 In the Reserve Department box, enter the inventory department
that is the reserve work in progress account.

Figure 1: The
Work in
Progress
General

Configuration
Parameters

When you enter the
information in the
Parameter Editor
window, the text

you added appears
in bold.
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5.4 In the ATF Invoice Format box, enter the invoice format to use
when printing after the fact information. You can enter up to four
characters in this box. This invoice format you specify here pro-
vides a unique look for after the fact invoice. Your Billing Depart-
ment should not send this format to the client. It is for in-house
use only and allows you to properly align costs that are out of bal-
ance between your payables and sales.

5.5 In the Purge Periods box, enter a two-digit business period for
purging balanced orders. The information you specify is the de-
fault business period when you purge information in the After the
Fact window. This box represents the number of periods that a
record has to be in order to purge if it is in balance. For example,
suppose it is period 12 and the work in progress record is period
11, if you set the Purge Periods box to 2, the system would not
purge the period 11 record.

6 After you set the General Configuration parameters, click Write-Off Op-
tions. The Write-Off Options appear. See Figure 2. You can use these
boxes to set the following parameters:

6.1 In the Default Salesperson box, enter the default salesperson num-
ber for the work in progress feature.

6.2 In the Additional Salesperson box, enter an additional salesperson
number for use with the Work in Progress feature.

6.3 In the Use Specific Salesperson box, type Y to use the salesperson
specified in these parameters. Type N to use the salesperson num-
ber on the order.

6.4 The Update Reserve Account box allows the auto write-off infor-
mation to be sent to the reserve department for general ledger in-
stead of the department for the vendor that has the highest bal-
ance when the auto write-off is performed. To allow automatic
write-offs to update the general ledger reserve account, set this
box to Y. When the automatic write-off is executed, the general
ledger reserve account is updated instead of the vendor depart-
ment that has the highest balance.  To allow automatic write-offs
to update the vendor department that has the highest balance, set
this box to N.

6.5 The Include Open Orders box works with the Purge Periods text
box. If you set this box to Y, the system purges open orders if
there is no WIP activity for the specified periods.

6.6 In the Marking Variance Value box, enter a dollar amount for WIP
variance. When marking WIP invoices, you have the ability to au-
tomatically mark all invoices plus or minus the dollar variance.
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The system uses this parameter when using the auto write-off fea-
ture. As long as the order is within the variance you specify in this
box, the system creates the ATF to get the order in balance.

6.7 In the Periods Since Last Posting box, enter the two-digit period
since the last WIP posting. Write-offs are only created for orders
that are completely invoiced (no open orders in the P-MASTER
file) and have no activity in WIP database for the specified num-
ber of periods.

If you set this box to Y, the system creates a write-off for an open
order if there is no activity in WIP for the specified number of pe-
riods.

6.8 In the View All ATF’s Password box, enter a password restricting
the ability to view all after the fact postings in the After the Fact
window. This allows you to view all ATF’s.

7 When you finish, click   to save your changes.

Figure 2: The
Write-Off

Options
Parameters
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Viewing Furniture Works in Progress
You can use this feature to monitor detail as the project progresses. You can
easily view cost detail for your orders.

1 Double-click . The Furniture Menu opens.

2 Double-click  .

3 The Work in Progress Limits dialog box opens. See Figure 3. By using
both sort and restriction options, you can set limits for the projects to
view. Click each box and enter the limits. When you finish, click Pro-
cess. You can set each of the following limits:

3.1 Click the down arrow in the View box to select the type of infor-
mation to view. You can view the information in a Summary for-
mat. This includes a summary of the work in progress informa-

Figure 3: The
Work in

Progress Limits
Dialog Box
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tion and totals. The Detail option lets you view all the line items
on the order as well as totals. The Formal option lets you view to-
tals.

3.2 Click the down arrow in the Order box to indicate the order in
which information displays. For example, to display information
in the following order: location, project and order, click the down
arrow in the Order box and choose the Loc/Project/Order option.

3.3 You can use the Location/To boxes to limit the orders to a specific
location. To do so, click the Location box and enter the beginning
location in the range. In the corresponding To box, enter the end-
ing location in the range.

3.4 You can use the Customer/To boxes to limit the to a specific cus-
tomer account number and department or by a range of custom-
ers. To do so, click the first Customer box and enter the beginning
customer account number in the range. In the second Customer
box, enter the department number. In the corresponding To boxes,
enter the ending customer account number in the range, along
with its corresponding department number.

3.5 Use the Project/To boxes to limit the orders to a specific project or
a range of projects. To do so, click the Project box and enter the
beginning project in the range. In the corresponding To box, enter
the ending project in the range.

3.6 Use the Salesperson/To boxes to limit the orders to a specific
salesperson number or a range of salespersons. To do so, click the
Salesperson box and enter the beginning salesperson number in
the range. In the corresponding To box, enter the ending salesper-
son number in the range.

3.7 In the Order/To boxes, you can limit the to a specific order num-
ber or a range of orders. To do so, click the Order box and enter
the beginning order number in the range. In the corresponding To
box, enter the ending order number in the range.

3.8 Click the Use Cutoff Date check box to limit the information by a
specific date. In the corresponding Date box, click the down arrow
to display a calendar. Select the date by which to limit. You can
move forward and backward through the months by clicking the
forward and backward buttons. When the date to limit by ap-
pears, click the date on the calendar.

3.9 The Or Period/Fiscal box consists of two limits: the first is the Pe-
riod box and the second is the Fiscal box. Click the Or Period box
to enter a specific business period by which to limit. In the corre-
sponding Fiscal box, enter the year by which to limit.
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3.10 Click the Closed Orders Only box to view only closed orders. To
view open (those orders not posted in O/E) as well as closed or-
ders, leave this box blank. Closed orders indicates that no other
dash ticket exists in the P-Project file. All related dash tickets have
been completed invoiced.

3.11 Click the Include Zero Balance Order check box to view orders
that have zero balances. To view orders that contain zero bal-
ances, check the Include Zero Balance Order box. To hide orders
that contain zero balances, leave the Include Zero Balance Order
box blank.

3.12 The Exclude Zero Balance Items check box only appears if you se-
lect the Detail option in the View box. Click this box to view zero
balance items in the Work in Progress window. To hide items that
contain a zero balance, leave the Include Zero Balance Order box
blank.

4 After you click Process, the Work in Progress window opens, displaying
the projects according to the limits you set. See Figure 4.

5 When you specify to view Detail in the Work in Progress window, you
can also add, change, and delete the work in progress information.

To do so, click the File menu and the Edit Password box appears. Enter
the password set in the Update Password box in the Furniture Work in
Progress General Configuration Parameters.

Figure 4:
Viewing

Information in
the Summary

Work in
Progress
Window
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6 You can now add, change or delete existing work in progress informa-
tion.

• Click  to add new work in progress information.

• Click  to change existing work in progress information.

• Click  to delete existing work in progress information.

7 When you finish, click  to save your changes.

8 To customize the boxes that appear in this window, click  . The Se-

lect Columns to Display dialog box opens as shown in Figure 5. This
dialog box contains the PO through Close boxes. The boxes that cur-
rently appear in the Work in Progress window are checked. To change
the display, click the appropriate boxes. When you finish making col-
umn adjustments, click OK.

9 You can print the information or export it to a file. Click . The Work

in Progress Preview dialog box opens.

10 In the Work in Progress window, you can access history information.
Click the line to view history detail. Select from the following:

10.1 To view order entry history, click . The O/E History window

opens and displays information for the line you selected.

10.2 To view purchase order history, click . The P/O History win-

dow opensand displays P/O detail for the line you selected.

Figure 5:
Selecting

Columns of
Information to

Display



Ensite Pro™ Office Furniture Edition Work in Progress & Job Costing

12 ECI² CONFIDENTIAL & PROPRIETARY

10.3 To view accounts payable history, click  . The A/P History

window opensand displays information for the line you selected.

10.4 To view accounts receivable history, click . The A/R History

window opensand displays A/R data for the line you selected.

11 When you finish viewing information, close the Furniture Works in
Progress window.

Changing After the Fact Information
You can use the After the Fact window to adjust your work in progress infor-
mation. This window allows you to make timely corrections to cost of goods
sold.

Note: Adding, changing, and deleting existing WIP data can only be per-
formed in the Detail window. In addition, you must specify the Update
Password from the General Configuration Work in Progress Parameters
window before making changes.

1 Double-click . The Furniture Menu opens.

2 Double-click . The Work in Progress After the Fact win-

dow opens.

3 When the cursor moves to the Order box, enter the order number.

4 Press Enter. The cursor moves to the Ref Nbr box. See Figure 6. Click
the box to change and enter the information.

5 When you finish, press Enter. The information moves down one line.
The cursor returns to the Ref Nbr box. You can continue to add as many
lines as necessary.

Note: If you make a mistake while entering information, you can also
right-click and select the Undo Add option.

6 When you finish entering information, click Post.

7 The cursor returns to the Order box. The system writes the information
to the ATF-BATCH file. Until you release the information, you can
change it in the After the Fact window.
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8 You can also delete a line you have added. To do so, click the line to se-
lect it and right-click. Select the Delete this ATF option.

9 While using the After the Fact window, you can also access other data-
base windows. Cick the Databases menu. Select the database to open.
You can choose from the O/E History window, the Customer window
or the Vendor window.

10 When you’re ready to release the information, use the Release function.

Releasing After the Fact Information
You can use the After the Fact window to release your work in progress infor-
mation. Until you release information, you can continue to change it. Once it
is released, you can no longer change the data.

1 To release the Work in Progress information, from within the After the
Fact window, click the Action menu and select Release.

2 The Release ATFs dialog box opens. See Figure 7. Check the Rel box
corresponding to the work in progress information to release. To select
all the boxes, you can click Select All.

3 Click Release.

Figure 6: The
After the Fact

Window
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4 The Select Printer for ATF Release dialog box opens, as shown in Figure
8. You can use this dialog box to specify the printer format and the logi-
cal name of the printer where the information prints.

5 When you’re ready, click Process.

6 After the procedure is complete, the cursor returns to the Order box in
the After the Fact window. The system updates the Work in Progress
window and the GL-BATCH file with the changes you made.

Purging After the Fact Information
You can use this feature to purge balanced WIP accounts. When you do, you
can limit the purge to a specified cutoff date. You can also save the purged in-
formation to an archived file

1 From the After the Fact window, click the Action menu and select Purge
WIP.

2 The Purge WIP Records dialog box opens, and the cursor moves to the
Cutoff Period box. Enter the date by which to limit this purge.

3 In the Archive to File box, specify to archive the information you are
purging to a file. If you check this box, the system defaults to save the
purged information to the file name and volume serial shown in the
File Name and Volume boxes.

Figure 7:
Releasing After

the Fact
Information
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4 You have the option of changing the file name and volume where the
saved data is stored.

• To change the file name, click the File Name box and enter the
new file name over the existing file name.

• To change the volume serial, click the down arrow in the Volume
box and select the volume serial where the information is saved.

• To select an existing file, click the Select File button. Scroll to the
area on your hard drive and select the file where the information
is saved.

5 When you are ready to purge the information, click Purge WIP. The in-
formation is purged to the file you specified.

Writing Off After the Fact Information
You can use this feature to write off after the fact information. When you do
so, the system automatically creates adjustments based on criteria you specify.
You can specify the dollar tolerance, the transaction age, select closed orders
only and write-off the reserve or cost of goods sold. This feature views the
variance to automatically create the ATF’s that are the order in balance. The
system creates records in the ATF-BATCH file. Once the file is released, the
system automatically updates the P-MASTER file with the transactions to an
invoice status (status B).

1 In the After the Fact window, click the Action menu and select Auto-
Write ATFs.

Figure 8:
Specifying

Printer
Information
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2 The Create ATF Records dialog box opens. See Figure 9. Click the
Write-Off ATF’s button. The Loading Records message appears while
the system retrieves the information.

3 The system writes off the information specified.

Job Costing
You can enter job costing items or hours for employees to a project. This lets
you keep details for audit purposes. You can create a table of hourly, regular
and overtime rates for an employee and ten categories in which to assign the
hours. For example, you can use this table to track the time a designer worked
on the project during a given time period.

You can post cost-only items as well. For example, you can track the cost of
additional hardware purchased for the project.

Using the Job Cost Approval window you can approve, change, or delete the
hours and/or cost-only items charged to a project. When you delete an item,
its status changes, but the item itself remains in the file for audit purposes.
However, deleted items do not move to the ticket. Once approved, all hours
and/or cost-only items flow to the ticket. Approved items and/or hours are
charged against commission. Unapproved items are not.

Job Cost Types are set up in the Parameter Editor window.

Figure 9: The
Create ATF

Records Dialog
Box
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Furniture Job Cost Types Parameters
When creating furniture projects, you can determine how much a particular
job costs. The Job Costing feature lets you estimate how much labor cost needs
to be added to a project. Use this box to set up parameters for job cost types.
You can assign job cost types to a salesperson in the Salesperson database.
You can set up job cost types to bill in intervals of a tenth of an hour, quarter
hour, half hour, or an hour.

1 From the Master Menu, double-click .

2 Double-click .

3 From the Parameter Editor window, double-click Furniture.

4 Double-click Job Cost Types. The Job Cost Types window opens. See
Figure 10.

5 To add a job cost type, press the Spacebar or click . Enter the informa-

tion for this job cost type.

5.1 Click the down arrow in the Location box and select the location.
This box defaults to location 1.

5.2 Select an item for this job cost type.

To enter the item number, click the Item Key box and enter the
number.

To use the query feature, click  to open the Item Query dialog

box. Select the item and click OK.

To select an uncataloged item, click . Click each box to enter

the information for this uncataloged item. When you finish, click
OK.

To use the catalog feature, click the Edit menu and select Catalog.
When the Catalog Explorer window opens, choose the item. Click
Select.

The Job Costing
feature is not

included in all
software packages

and may require
authorization. For
more information,
contact ECI² sales.
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5.3 The system automatically completes the Item Description box. To
change the description, click the Item Description box and enter
the new item description over the existing description.

5.4 Click the down arrow in the Time Billing Interval box to select
how to bill the time for this job cost type. You can select Tenth
hour, Quarter hour, Half hour and Hour.

5.5 Click the Dept box and enter a department to post this job cost.

5.6 Click the Comm Code box and enter the commission code. You
use these parameters to assign two commission codes for each job
cost type: one for commissionable items and the other for non-
commissionable items. When you do, you must specify different
codes so the commissionable and non-commissionable costs go
onto separate lines or onto separate tickets. If you assign different
codes, they are reported separately in the Furniture Project Man-
agement window. This allows you to easily track the information.

5.7 Click the Non Comm Code box and enter the non-commission
code for this job cost type.

6 Click  to close the Job Cost Types dialog box.

7 Job Cost Types now appears in bold in the Parameter Editor window.
Click   to save your changes.

Figure 10: The
Job Cost Types

Window
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Adding Post Hour Costs

1 Double-click .

2 Double-click . The Post Hour Cost window opens. See Figure

11.

3 To add a new hours, click .

4 Retrieve the individual for whom you are posting hours. To do so, click
the Salesperson box and enter the salesperson number. If you do not re-
member the salesperson number, you can click  to open the Salesper-

son Query dialog box.

5 Retrieve the project for which you are posting hours. To do so, click the
Project Number box and enter the project number. If you do not remem-
ber the project number, you can click  to open the Project Query dia-

log box.

6 To apply the hours to a specific ticket within the project, click the Ticket
box and enter the pick ticket number. If you do not remember the pick
ticket number, click  to open the Order Browse dialog box.

7 After you select the project, click the Job Cost Type box and enter the
type of labor you are posting, Installation Hours, for example.

8 Click the Regular Time or Overtime boxes and enter the number of
hours this individual works on this project.

9 Click the Ticket box. When the down arrow appears, you can apply this
labor toward a specific pick ticket within this project. To do so, click the
down arrow and select the ticket.

10 In the Notes box, enter any text that helps you identify this hourly cost.

11 When you finish entering information for this line, press Enter. The cur-
sor moves down one line and returns to the Job Cost Type box.

12 You can continue to enter as many hours as necessary. When you're
ready to post the hour information you specified, click Post.
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Adding Post Items

1 Double-click . The Furniture Menu opens.

2 Double-click  . The Post Item Cost window opens.

3 To add a new item, click .

4 Retrieve the project for which you are posting items. To do so, click the
Project Number box and enter the project number. If you do not remember
the project number, you can click  to open the Project Query dialog box.

5 To apply the hours to a specific ticket within the project, click the Ticket
box and enter the pick ticket number. If you do not remember the pick
ticket number, click  to query.

6 After you select the project, click the ItemKey box and enter the number
of the item to post. If you don't know the item stock number, you can
also click  to open the Item Query dialog box. If this is an item that

you don't stock, click .

7 In the Uncataloged Item Information dialog box, enter the item number,
the name or abbreviation of the manufacturer, a description, the general
ledger department the item is assigned to, a selling unit of measure, the
list price, and the cost. Click OK.

Figure 11: The
Post Hour Cost

Window
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8 The system retrieves the item that most closely matches the one you
specified. At this point, you can change item information. To do so, click
the Dept, Unit, Cost, Quantity, Ticket, and Notes boxes and enter the in-
formation for this item.

9 When you finish entering information for this item, press Enter. The
cursor moves down one line and returns to the ItemKey box.

10 You can continue to enter as many items as necessary. When you're
ready to post the item information you specified, click Post.

Posting Furniture Item and Hour Costs to a Project

1 Double-click . The Furniture Menu opens.

2 Double-click . The Job Cost Approval window opens.

3 Retrieve the project to apply the item and hour cost information. To do
so, click the Project Needing Approved box and enter the project num-
ber. If you do not remember the project number, you can click  to

open the Project Query dialog box.

4 In the Hour Postings section of the window, the system displays the
hour information that has been specified for this project in the Post
Hour Cost window. At this point, you can click the Non Commission
Hours Regular and Overtime boxes and enter the number of hours for
this project. As you enter hours, the system subtracts the hours you
specify from the Commission Hours Regular and OverTime boxes.

5 When finished specifying hour information, click the Approved box for
each line to post to this project. See Figure 12. To approve all the hours,
click Check All.

6 In the Item Postings section of the dialog box, the system displays the
item information that has been specified for this project in the Post Item
Cost window. At this point, you can change the information in the
Dept, Comm Code, Quantity, and Cost boxes for each line item.

7 When finished specifying item information, click the Approved box for
each line item to post to this project. To approve all the items, click
Check All.

8 To post the hour information to the project, click Approve Hours. To
post item information to the project, click Approve Items.
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9 Click  or click the View menu and select the Post to Ticket option.

10 The system displays the Furniture Create Tickets dialog box. Click the
down arrow in the Ticket box to select a ticket to apply the item or hour
information. If you do not specify a ticket, the system creates a new
pick ticket number.

11 Click Create Lines.

Figure 12: The
Job Cost

Approval
Window
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